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1. Safety

System operation assumes knowledge of the operating instructions.

1.1 Symbols Used

The following symbols are used in these operating instructions:

Indicates a hazardous situation which, if not avoided, may result in minor or mode-
rate injury.

Indicates a situation that may result in property damage if not avoided.

Indicates a user action.

i Indicates a tip for users.

Measure Indicates hardware or a software button/menu.

1.2 Warnings

Connect the power supply and the display/output device according to the safety regulations for electrical 
equipment.

 > Risk of injury

 > Damage to or destruction of the camera

Avoid the alignment of the camera to intensive energy sources (e.g. devices which emit laser radiation or 
reflections of such equipment). This is also valid if the camera is switched off.

 > Effect on the accuracy of the measurement

 > Irreparable defect of the infrared detector

Avoid static electricity, arc welders, and induction heaters. Keep away from very strong EMF (electromagnetic 
fields).

 > Damage to or destruction of the camera
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Avoid shocks, impacts and vibration to the camera.
 > Damage to or destruction of the camera

The supply voltage must not exceed the specified limits.
 > Damage to or destruction of the camera

No solvent-based cleaning agents may have an effect on the camera (neither for the optics nor the housing).
 > Damage to or destruction of the camera

Avoid abrupt changes of the ambient temperature.
 > Incorrect display of the device

Protect the USB cable against damage.
 > Failure of the camera

1.3 Notes on CE Marking

The following apply to the thermoIMAGER TIM: 
 - EU Directive 2014/30/EU
 - EU Directive 2011/65/EU 

Products which carry the CE mark satisfy the requirements of the EU directives cited and the relevant appli-
cable harmonized European standards (EN). The measuring system is designed for use in industrial environ-
ments.

The EU Declaration of Conformity and the technical documentation are available to the responsible authori-
ties according to the EU Directives.
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1.4 Intended Use
 - The thermoIMAGER TIM is designed for use in industrial and laboratory areas. It is used for measuring the 

surface temperature based on the emitted energy of objects, see 10.
 - The system must only be operated within the limits specified in the technical data, see 2.
 - The system must be used in such a way that no persons are endangered or machines and other material 

goods are damaged in the event of malfunction or total failure of the system.
 - Take additional precautions for safety and damage prevention in case of safety-related applications.

1.5 Proper Environment
 - Protection class:   IP67 (NEMA-4)
 - Operating temperature:   0 ... +50 °C (+32 ... +122 °F)
 - Storage temperature:   -40 ... +70 °C (-40 ... +158 °F)
 - Relative humidity:  10 ... 95 %, non-condensing

Avoid abrupt changes of the ambient temperature.
 > Incorrect display of the device
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2. Technical Data

2.1 Functional Principle

The thermoMETER TIM 8 and the thermoIMAGER TIM 40 calculates the surface temperature based on the 
emitted infrared energy of objects, see 10. The two-dimensional detector (FPA - focal plain array) allows a 
measurement of an area and will be shown as thermographic image using standardized palettes. The radio-
metric processing of the picture data enables the user to do a comfortable detailed analysis with the software 
TIM Connect.

2.2 Model Overview

The cameras of the TIM series are available in the following basic versions:

Model Type Temperature range Spectral range Frame rate Typical applications

thermoMETER 
TIM 8

IR -20 to 900 °C 8 - 14 μm USB/Ethernet: 
50 Hz

Surface measure-
ments in industrial 
application, autono-
mous operation with 
automatic spot finder

thermoIMAGER 
TIM 40

IR -20 to 900 °C 8 - 14 μm USB: 
80 Hz / 27 Hz

Real-time thermo-
graphic images in 
high speed; Detection 
of smallest tempera-
ture differences

thermoIMAGER 
TIM 41

IR -20 to 900 °C 8 - 14 μm Ethernet: 25 HZ 
USB: 4 Hz

Surface measure-
ments in industrial 
application, autono-
mous operation with 
automatic spot finder
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2.3 General Specifications

Model thermoMETER TIM 8 thermoIMAGER TIM 40 thermoIMAGER TIM 41

Protection class IP 67 (NEMA-4) 1

Operating temperature 0 ... 50 °C (+32 ... +122 °F)

Storage temperature -40 ... 70 °C (-40 ... +158 °F)

Relative humidity 10 ... 95 %, non-condensing

Material (housing) Stainless steel

Dimensions 36 x 90 mm / M30 36 x 100 mm / M30

Weight (inclusive lens) 201 - 221 g 
(depending on optics)

216 - 220 g 
(depending on optics)

Cable length (USB) USB 1 m (Standard), 3 m, 5 m 1 m (Standard), 3 m, 5 m, 
10 m, 20 m

1 m (Standard), 3 m, 5 m

Ethernet/ RS485 100 m - 100 m

Vibration 1 IEC 68-2-6: (sinus shaped), see 2.4

IEC 60068-2-64 (broadband noise), see 2.4

Shock 1 IEC 68-2-27: 25 g and 50 g, see 2.4

1) Used standards for vibration and shock
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2.4 Vibration / Shock

2.4.1 Used Standards

IEC EN 60068-1: 1995-03 Environmental testing - Part 1: General and guidance

IEC 60068-2-6: 2008-10 Environmental testing - Part 2-6: Tests - Test Fc: Vibration   
  (sinusoidal)

IEC 60068-2-27: 2010-02 Environmental testing - Part 2-27: Test Ea and guidance:   
  Shock

IEC 60068-2-47: 2006-03 Environmental testing - Part 2-47: Mounting of specimens  
  for vibration, impact and similar dynamic tests

IEC 60068-2-64: 2009-04 Environmental testing - Part 2-64: Tests -  
  Tests Fh: Vibration, broadband random and guidance

2.4.2 Stress Program (Camera in Operation)

Shock, half sinus 25 g – testing Ea 25 g (acc. IEC 60068-2-27)

Acceleration 245 m/s2 (25 g)

Pulse duration 11 ms

Number of directions 6 (3 axes with 2 directions each)

Duration 600 shocks (100 shocks each direction)

Shock, half sinus 50 g – testing Ea 50 g (acc. IEC 60068-2-27)

Acceleration 490 m/s2 (50 g)

Pulse duration 11 ms

Number of directions 6 (3 axes with 2 directions each)

Duration 18 shocks (3 shocks each direction)



Page 13

Technical Data

thermoMETER TIM 8 / thermoIMAGER TIM 40 / TIM 41

Vibration, sinus shaped – testing Fc (acc. IEC60068-2-6)

Frequency range 10 - 500 Hz

Acceleration 29.42 m/s2 (3 g)

Frequency change 1 octave/ min

Number of axes 3

Duration 1:30 h (3 x 0.30 h)

Vibration, broadband noise – testing Fh (acc. IEC60068-2-64)

Frequency change 10 - 2000 Hz

Acceleration, effective 39.3 m/s2 (4.01 gRMS)

Frequency spectrum 10 - 106 Hz 0.9610 (m/s2)2/Hz (0.010 g2 /Hz)

106 - 150 Hz +6 dB/ octave

150 - 500 Hz 1.9230 (m/s2)2/Hz (0.020 g2 /Hz)

500 - 2000 Hz -6 dB/ octave

2000 Hz 0.1245 (m/s2)2/Hz (0.00126 g2 /Hz)

Number of axes 3

Duration 3 h (3 x 1 h)
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2.5 Electrical Specifications

Model thermoMETER TIM 8 thermoIMAGER TIM 40 thermoIMAGER TIM 41

Power supply USB/ PoE/ 5 - 30 VDC USB USB/ PoE/ 5 - 30 VDC

Current draw max. 500 mA

AO: Output Process Inter-
face (PIF out)

0/4 - 20 mA 0 - 10 V 0/4 - 20 mA

(Main measure area, measure area, internal temperature, flag status, alarm, frame sync, fail-safe,  
external communication), see A 12.

AI: Input Process Interface 
(PIF in)

0 - 10 V (Emissivity, ambient temperature, reference temperature, uncommitted value, flag control, trig-
gered recording, triggered snapshots, triggered line-scanner, triggered event grabber,  

reset peak-/valley-hold), see A 12.

DI: Digital Input Process 
Interface

Flag control, triggered recording, triggered snapshots, triggered line-scanner, triggered event grabber, 
reset peak-/valley-hold

DO: Digital Output Pro-
cess Interface

Flag Status, alarm, frame sync, fail-safe, external communication

Digital interface USB 2.0/ Ethernet/ RS485 USB 2.0/ optional USB to GigE 
(PoE) conversion

USB 2.0/ Ethernet/ RS485
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2.7 Measurement Specification 

Model thermoMETER TIM 8 thermoIMAGER TIM 40 thermoIMAGER TIM 41
Temperature ranges 
(scalable)

-20 ... 100 °C;  
0 ... 250 °C;  

(20) 150 ... 900 °C 1)

20 ... 100 °C;  
0 ... 250 °C;  

(20) 150 ... 900 °C 1)

-20 ... 100 °C; 0 ... 250 °C;  
(20) 150 ... 900 °C 1)

Spectral range 8 - 14 μm

Detector UFPA,  
80 x 80 Pixel @ 50 Hz

UFPA,  
382 x 288 Pixel @ 80 Hz/27 Hz

UFPA,  
Ethernet: 384 x 240 Pixel @ 25 Hz 

USB: 384 x 240 Pixel @ 4 Hz
Lenses (FOV) 12° x 12° (F=1,0);  

30° x 30° (F=0,9);  
55° x 55° (F=0,9);  
80° x 80° (F=0,9)

18° x 14° (F=1,1);  
29° x 22° (F=0,9);  
53° x 38° (F=0,9);  
80° x 54° (F=0,9)

18° x 12° (F=1,1); 29° x 18° (F=0,9);  
53° x 31° (F=0,9); 80° x 44° (F=0,9)

Optical resolution (D:S) 190:1 (12° optic) 390:1 (18° optic)
System accuracy 2) ±2°C or ±2 %
Temperature resolution 
(NETD)

100 mK 80 mK

Warm-up time 10 min
Emissivity 0.100 ... 1.100
Software TIMConnect

1) Accuracy statement effective from 150 °C
2) At ambient temperature 23±5 °C; whichever is greater.
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3. Delivery

3.1 Unpacking, Included in Delivery

1 thermoMETER TIM 8, thermoIMAGER TIM 40 or thermoIMAGER TIM 41

1 USB cable (1 m 1)

1 Ethernet PoE cable: 1 m (only for thermoIMAGER TIM 41)

1 Mounting nut and mounting bracket (adjustable in one axis, tripod thread)

1 Process interface cable inclusive terminal block (1 m)

1 USB stick with software package TIM Connect

1 Assembly instructions

 Carefully remove the components of the measuring system from the packaging and ensure that the 
goods are forwarded in such a way that no damage can occur.

 Check the delivery for completeness and shipping damage immediately after unpacking.
 If there is damage or parts are missing, immediately contact the manufacturer or supplier.

Optional accessories are available in the appendix, see A 1.

3.2 Storage
 - Storage temperature:  -40 ... +70 °C (-40 ... +158 °F)
 - Relative humidity: 10 ... 95 %, non-condensing

1) The camera plug of USB cable (1 m) does not feature an IP67 protection class. For industrial applications 
there are cables with 1 m, 3 m, 10 m and 20 m with IP67 available as optional accessories.
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4. Optical Charts

i Make sure that the focus of thermal channel is adjusted correctly. The cameras have a motorized focus, 
which can be adjusted in the TIM Connect Software via Menu View > Windows > Distance or over 
the icon . An adjustment to the left leads to the focus setting “near” and an adjustment to the right to 
the focus setting “infinite”.

Fig. 1 Motorized focus settings in TIM Connect software

The variety of different lenses offers the possibility to precisely measure objects in different distances. We of-
fer lenses for close, standard distances and large distances.

i Please note that the TIM camera has a fixed optic. A change of optics is not possible. 
Please note that the motorized focus should only be used for startup and installation purposes and that 
permanent movement of the focus motor is not allowed.

Different parameters are important if using infrared cameras. They display the connection between the dis-
tance of the measured object and the size of the pixel, see Fig. 3, see Fig. 4, see Fig. 5.
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Fig. 2 Dependency between field of view (FOV) and distance

HFOV Horizontal enlargement of the total measuring at object level
VFOV Vertical enlargement of the total measuring at object level
IFOV Size at the single pixel at object level
DFOV Diagonal dimension of the total measuring field at object level
MFOV Recommended, smallest measured object size of 3 x 3 Pixel (thermoIMAGER TIM 40 / TIM 41) 

and 2 x 2 (thermoMETER TIM 8), not shown in the drawing above, see Fig. 2.
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Geometric resolution for ideal temperature measurement

When designing optics for measuring IR cameras, special attention must be paid to the quality of detail 
contrast with which an object can be represented in the image. This is described by the modulation transfer 
function (MTF). Since in contrast to visual cameras, with IR cameras the thermal contrast is of more interest, 
this is used together with the slit response function (SRF). The result is determined by the number of pixels 
an object needs to fill to allow its temperature to be measured exactly. In high-performance infrared optical 
systems, this is 3×3 pixels or 2x2 pixels. A high-performance camera lens also allows a larger measuring 
distance with the same number of pixels of the detector, or the precise temperature measurement of smaller 
structures and objects. The 3×3 pixel (2x2 pixel) geometry is described as MFOV (measurement field of 
view) - one single pixel on the object surface is described as IFOV (instantaneous field of view). The MFOV is 
comparable with the measuring spot definition with infrared thermometers.

The following tables with examples showing what spot sizes and pixel sizes will be reached in which distance. 
For individual configuration there are different lenses available. Wide angle lenses have a radial distortion due 
to their large opening angle; the software TIM Connect has an algorithm which corrects this distortion. As an 
alternative to the tables below, the optics calculator can also be used. You will find the latest software at:
https://www.micro-epsilon.com/temperature-sensors/thermoIMAGER/optics/
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4.1 Lenses thermoMETER TIM 8

TIM 8
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Distance to measurement object [m]

0.05 0.1 0.2 0.3 0.5 1 2 4 6 10 30 100

30 ° 
Standard lens

5
30° 
30° 
6.67 mrad

0.2 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.028  
0.028  
0.33

0.056  
0.056  
0.67

0.111  
0.111  
1.33

0.167  
0.167  
2.0

0.279 
0.279 
3.33

0.557  
0.557  
6.67

1.115  
1.115  
13.33

2.23 
2.23 
26.67

3.346  
3.346  
40.0

5.6  
5.6 
66.67

16.7  
16.7  
200.0

55.8  
55.8 
666.67

12 ° 
Telephoto lens

13
12° 
12° 
2.66 mrad

0.3 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.022  
0.022  
0.3

0.043  
0.043 
0.5

0.065  
0.065  
0.8

0.21  
0.11 
1.3

0.21  
0.21  
2.7

0.43 
0.43 
5.3

0.85 
0.85 
10.6

1.28  
1.28  
15.9

2.1  
2.1 
26.6

6.4  
6.4 
79.7

21.3  
21.3  
265.6

55 ° 
Wide angle 
lens

3
55° 
55° 
11.15 mrad

0.2 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.057  
0.057  
0.6

0.110  
0.110  
1.2

0.218  
0.218  
2.3

0.325  
0.325  
3.4

0.539  
0.539  
5.6

1.07  
1.07 
11.2

2.14  
2.14 
22.4

4.27 
4.27 
44.6

6.41  
6.41  
66.9

10.7  
10.7  
111.5

32.0  
32.0  
334.5

106.7 
106.7 
1114.8

80 ° 
Super wide 
angle lens

2
80° 
80° 
15.45 mrad

0.2 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.090  
0.090  
0.08

0.174  
0.174  
1.6

0.343  
0.343  
3.2

0.509  
0.509  
4.7

0.884 
0.88 
7.8

1.682 
1.682 
15.5

3.357  
3.357  
31.0

6.708 
6.08 
61.9

10.058 
10.058 
92.8

16.8  
16.8  
154.6

50.3 
50.3 
463.7

167.5 
167.5 
1545.5

Fig. 3 Table with examples (TIM 8) showing what spot sizes and pixel sizes will be reached in which distance

FOV: Horizontal enlargement of the total measuring field at object level
VFOV: Vertical enlargement of the total measuring field at object level
IFOV: Size of the single pixel at object level

1) The accuracy of measurement can be outside of the specifications for distances below the defined minimum distance.
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4.2 Lenses thermoIMAGER TIM 40

TIM 40
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Distance to measurement object [m]

0.05 0.1 0.2 0.3 0.5 1 2 4 6 10 30 100

29 °  
Standard lens

13
29° 
22° 
1.3 mrad

0.35 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.059  
0.043  
0.2

0.111  
0.082  
0.3

0.16  
0.12  
0.4

0.27 
0.20 
0.7

0.53  
0.39  
1.4

1.06  
0.78 
2.8

2.1 
1.5 
5.5

3.2 
2.3 
8.3

5.3  
3.9 
13.8

15.8 
11.6 
41.2

52.5 
38.5 
137.4

18 °  
Telephoto lens

20
18° 
14° 
0.9 mrad

0.35 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.069 
0.051 
0.2

0.102 
0.076 
0.3

0.17  
0.12 
0.4

0.33  
0.25 
0.9

0.66 
0.49 
1.7

1.30 
0.98 
3.4

1.9  
1.5 
5.1

3.2 
2.5 
8.5

9.7 
7.4 
25.4

32.4 
24.6 
84.8

53 ° 
Wide angle 
lens

8
53° 
38° 
2.2 mrad

0.25 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.099 
0.071  
0.26

0.20  
0.14  
0.53

0.30 
0.21 
0.78

0.49  
0.34  
1.3

0.99  
0.68 
2.6

2.0 
1.4 
5.2

4.0 
2.7 
10.4

5.9 
4.1  
15.5

9.9 
6.8 
25.9

29.6 
20.4 
77.5

98.6 
68.1 
258.2

80 ° 
Super wide 
angle lens

6
80° 
54° 
3.0 mrad

0.2 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.084  
0.056 
0.2

0.16  
0.11  
0.4

0.32  
0.21  
0.8

0.48  
0.331  
1.3

0.81 
0.51 
2.1

1.6 
1.0 
4.2

3.3  
2.0  
8.5

6.5 
4.1 
17.0

9.8 
6.1 
25.7

16.6  
10.2  
43.6

49.9 
30.6 
130.7

166.4 
101.9 
435.5

Fig. 4 Table with examples (TIM 40) showing what spot sizes and pixel sizes will be reached in which distance

FOV: Horizontal enlargement of the total measuring field at object level
VFOV: Vertical enlargement of the total measuring field at object level
IFOV: Size of the single pixel at object level

1) The accuracy of measurement can be outside of the specifications for distances below the defined minimum distance.
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4.4 Lenses thermoIMAGER TIM 41
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Distance to measurement object [m]

0.05 0.1 0.2 0.3 0.5 1 2 4 6 10 30 100

29 ° 
Standard lens

13
29° 
18° 
1.4 mrad

0.35 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.059  
0.036  
0.2

0.112  
0.068  
0.3

0.17  
0.10  
0.4

0.27 
0.16 
0.7

0.53  
0.32  
1.4

1.07  
0.64 
2.8

2.1 
1.3 
5.5

3.2 
1.9 
8.3

5.3  
3.2 
13.8

15.9 
9.5 
41.3

52.9 
31.7 
137.7

18 ° 
Telephoto lens

20
18° 
12° 
0.9 mrad

0.35 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.069 
0.043 
0.2

0.102  
0.064 
0.3

0.17  
0.10 
0.4

0.33  
0.21 
0.9

0.66 
0.41 
1.7

1.31 
0.82 
3.4

2.0  
1.2 
5.1

3.3 
2.1 
8.5

9.8 
6.1 
25.5

32.6 
20.5 
84.8

53 °  
Wide angle 
lens

8
53° 
31° 
2.6 mrad

0.25 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.100 
0.057  
0.3

0.20  
0.11  
0.5

0.30 
0.17  
0.8

0.49  
0.28  
1.3

0.99  
0.55 
2.6

2.0 
1.1 
5.1

4.0 
2.2 
10.3

5.9  
3.3  
15.5

9.9 
5.5 
25.8

29.7 
16.5 
77.2

98.9 
54.9 
257.4

80 ° 
Super wide 
angle lens

6
80° 
44° 
4.3 mrad

0.2 m
HFOV [m] 
VFOV [m] 
IFOV [mm]

0.084  
0.044  
0.2

0.16  
0.08  
0.4

0.32  
0.17  
0.8

0.48  
0.25  
1.3

0.81 
0.41 
2.1

1.6 
0.8 
4.2

3.3  
1.6  
8.5

6.5 
3.2 
16.9

9.8 
4.8 
25.5

16.6  
8.0 
43.4

49.9 
24.1 
130.0

166.4 
80.4 
433.2

Fig. 5 Table with examples (TIM 41) showing what spot sizes and pixel sizes will be reached in which distance

FOV: Horizontal enlargement of the total measuring field at object level
VFOV: Vertical enlargement of the total measuring field at object level
IFOV: Size of the single pixel at object level

1) The accuracy of measurement can be outside of the specifications for distances below the defined minimum distance.
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5. Mechanical Installation

The thermoMETER TIM 8 and the thermoIMAGER TIM 40 / TIM 41 are equipped with a metric M30x1 thread 
and can be installed either directly via the sensor thread or with help of the supplied mounting nut (standard) 
and adjustable mounting bracket (standard) to a mounting device available, see Fig. 7.

5.1 Dimensional Drawings

Fig. 6 thermoMETER TIM 8 / thermoIMAGER TIM 40 / TIM 41 with mounting bracket

Fig. 7 Mounting bracket, adjustable in one axis, with tripod thread 

i For correct orientation, the USB port must be on the left side and the PIF port on the right side, see Fig. 
8, see Fig. 9, see Fig. 10.
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Fig. 8 Dimensional drawing thermoMETER TIM 8, dimensions in mm



Page 25

Mechanical Installation

thermoMETER TIM 8 / thermoIMAGER TIM 40 / TIM 41

Fig. 9 Dimensional drawing thermoMETER TIM 40, dimensions in mm
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Fig. 10 Dimensional drawing thermoIMAGER TIM 41, dimensions in mm
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Fig. 11 Industrial/stackable PIF (Process Interface) - electronic box, control box shutter, dimensions in mm
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6. Electrical Installation

At the back side of the thermoMETER TIM 8 / thermoIMAGER TIM 41 and the thermoIMAGER TIM 40 cam-
eras there are the two connector plugs, see Fig. 12, see Fig. 13.

Fig. 12 Back side of the thermoMETER TIM 8 /  
thermoIMAGER TIM 41 with connectors

Fig. 13 Back side of the thermoIMAGER TIM 40 with 
connectors

1 Plug for USB/ Ethernet 1) / PoE cable 1 Plug for USB cable

2 Plug for in- and outputs or RS485 2 Plug for PIF cable

1) When using the Ethernet interface, either a PoE source or a 5 ... 30 V DC power supply via the terminal 
block must be used.
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6.1 Process Interface

6.2 Process Interface thermoMETER TIM 8 / thermoIMAGER TIM 41

The thermoMETER TIM 8 / thermoIMAGER TIM 41 is equipped with an integrated process interface (cable 
with terminal block included in scope of supply), which can be programmed via the software as an direct ana-
log input (AI) / digital input, as an direct analog output (AO) in order to control the process or as an RS485 
interface 1). The signal level is 0 - 10 V for AI, 24 V for DI and 0/4 - 20 mA for AO.

The process interface can be activated choosing the following options:

Analog Input (AI) Emissivity, ambient temperature, reference temperature, uncommitted value, flag 
control, triggered recording, triggered snapshots, triggered line-scanner, triggered 
event grabber, reset peak-/valley-hold

Analog Output (AO) Main measure area, measure area, internal temperature, flag status, alarm, frame 
sync, fail-safe, external communication

1) Power supply only necessary when using the Ethernet connection (without PoE) or self-sufficient opera-
tion.
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Fig. 14 Configuration terminal block thermoMETER TIM 8 / thermoIMAGER TIM 41

Designation Description Color
Shield Black

GND 0 V Ground Brown

VCC 5 - 30 V Power supply 1) White 

IN A Analog/Digital Input or RS485 (A) Green

OUT B Analog output or RS485 (B) Yellow

GND ISO Isolated Ground for IN and OUT Gray

1) Power supply only necessary when using the Ethernet connection (without PoE) or self-sufficient operation
(minimum voltage when using the Ethernet connection: 12 V)
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The thermoMETER TIM 8 / thermoIMAGER TIM 41 provides the following direct inputs and outputs:

Designation Description max range / status

AI

or

DI

Analog input 0 - 10 V 1)

Digital input 
(Low-active = 0 ... 0.6 V)

24 V

AO Analog output

Alarm output

0/4 - 20 mA
0/4 - 20 mA

In addition to the above direct in- and outputs, the TIM 8 / TIM 41 has an RS485 interface. This interface can 
be used to control the external industrial PIF.

1) The AI is designed for max. 24 V, the voltage level above 10 V is not interpreted.
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6.3 Process Interface thermoIMAGER TIM 40

i The process interface (electronics within cable as well as industrial interface) must be powered sepa-
rately (5 - 24 VDC). 

 Connect the PIF cable to the camera before switching on the power.

The TIM is equipped with a process interface (cable with integrated electronics and terminal block), which 
can be programmed via the software as an Analog Input (AI) and Digital Input (DI) in order to control the 
camera or as an Analog Output (AO) in order to control the process. The signal level is always  
0 - 10 V (DI = 24 V).

The process interface can be activated choosing the following options:

Analog input (AI) Emissivity, ambient temperature, reference temperature, uncommitted value, flag 
control, triggered recording, triggered snapshots, triggered line-scanner, trig-
gered event grabber, reset peak-/valley-hold

Analog output (AO) Main measure area, measure area, internal temperature, flag status, alarm, 
frame sync, fail-safe, external communication

Digital input (DI) Flag control, triggered recording, triggered snapshots, triggered line-scanner, 
triggered event grabber, reset peak-/valley-hold
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Fig. 15 Configuration terminal block thermoIMAGER TIM 40

Designation Description Color
Shield Black

GND Ground Brown

DI Digital input Gray

Vcc Power supply, 5 … 24 V DC White

AI Analog input Green

AO Analog output Yellow

The standard process interface can be activated choosing the following options:

Designation Description max range 1) / status

AI Analog input 0 - 10 V 2)

DI Digital input 
(Low-active = 0 ... 0.6 V)

24 V

AO Analog output 
Alarm output

0 - 10 V 
0/ 10 V

1) Depending on supply voltage; for 0 - 10 V on the AO the PIF has to be powered with min. 12 V.
2) The AI is designed for max. 24 V, the voltage level above 10 V is not interpreted.
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6.4 Pin Assignment thermoMETER TIM 8 / thermoIMAGER TIM 41

Pin USB Ethernet PIF

1 VCC VCC

2 D+ RS485 or AO

3 D- RS485 or AI

4 Tx+ GND

5 Tx- GND-ISO

6 Rx+

7 Rx-

8 GND

Fig. 16 Rear side thermoMETER TIM 8 / thermoIMAGER TIM 41 connector
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6.5 Pin Assignment thermoIMAGER TIM 40

Pin USB PIF

1 VCC INT

2 GND SDA (I2C)

3 D- SCL (I2C)

4 D+ DGND

5 - 3.3 V (Out)

Fig. 17 Rear side thermoIMAGER TIM 40 connector

If the process interface of the camera is directly connected to external hardware 1 (without using the supplied 
PIF cable) an activation of the field Support proprietary PIF cable in the menu Tools > Configu-
ration > Device (PIF) in the TIM Connect software is necessary.

Fig. 18 Support proprietary PIF cable

i Consider that the input of the PIF is not protected if there is a direct PIF connection!

In this case, avoid a voltage > 3 V at INT pin.
 > Destruction of the camera

1) We recommend using only a switching contact between INT and DGND as external hardware (button, 
relay).
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7. Commissioning
 Please install at first the software TIM Connect from the delivered USB stick, see 9.1.

i Further information regarding software installation as well as software features you will find in the oper-
ating instructions from the delivered USB stick.

 Now you can connect the thermoIMAGER TIM camera into an USB port (USB 2.0) of your PC.
 If connecting the thermoIMAGER TIM camera and the computer please plug at first the USB cable into 

the camera and then into the computer.
If disconnecting the thermoIMAGER TIM camera and the computer please remove at first the USB cable from 
the computer and then from the camera.

 > Damage to or destruction of the camera

After the software has been started, you should see the live image from the camera inside a window on your 
PC screen, see Fig. 19.

Fig. 19 Live image of camera

At first start of software you will be asked to install the calibration data of camera. You will find them on the 
delivered USB stick or can be accessed online via the Internet.

  Adjust the focus of the image by using the distance function in the software (menu View > Windows 
> Distance or over the icon :

Fig. 20 Window Distance
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8. Instructions for Operation

8.1 Cleaning

Lens cleaning: Blow off loose particles using clean compressed air. The lens surface can be cleaned with a 
soft, humid tissue moistened with water or a lens cleaner (e.g. Purosol or B+W Lens Cleaner).

Never use cleaning compounds which contain solvents (neither for the lens nor for the housing).
 > Destruction of the sensor and/or the controller
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9. Software TIM Connect

9.1 Minimum System Requirements
 - Windows 7, Windows 10 
 - USB interface 
 - Hard disc with at least 30 MByte of free space
 - At least 128 MByte RAM

A detailed description is provided in the software manual on delivered USB stick. See also Help menu in the 
TIM Connect software under Help > Documentation.

9.2 Installation and Initial Operation

i All drivers are booted via Windows OS automatically. A driver installation is not necessary. By default 
the program starts automatically in the installed language.

 1. Insert the included USB stick an Ihrem PC an.
 2. Please start the Setup.exe. Follow the instructions of the wizard until the installation is finished.

The installation wizard places a launch icon on the desktop and in the start menu: Start\Programs\TIM 
Connect.

 3. To connect the camera to the PC, plug the USB cable to the camera first. Afterwards connect it with 
the PC (to disconnect the camera and the computer remove the USB cable from the computer first and 
then disconnect it from the camera). 

 4. Start the software.

At the initial start the software asks for the calibration files which are available via internet or on the USB stick 
(only for TIM 40). With the TIM 8 / TIM 41, the calibration files are already included in the device.

 5. Choose the desired language in the menu Tools > Language.
 6. Adjust the focus of the image by using the distance function in the software (Menu View > Win-
dows > Distance or over the icon :
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Fig. 21 Window Distance 

Fig. 22 Software window
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i Further information regarding software installation as well as software features you will find in the opera-
tion instructions. 
They are available online at: 
http://www.micro-epsilon.com/download/manuals/man--thermoIMAGER-TIM-Connect--en.pdf

1 IR image from the camera

2 Temperature profile: Shows the temperatures along max. 2 lines at any size and position in the image.

3 Control displays: Displays all temperature values in the defined measure areas like Cold Spots, Hot 
Spots, temperature at cursor, internal temperature and chip temperature.
Alarm settings: Bar showing the defined temperature thresholds for low alarm value (blue arrow) and 
high alarm value (red arrow). The color of numbers within control displays changes to red (when 
temp. above the high alarm value) and to blue (when temp. below the low alarm value).

4 Temperature of measure area: Analyses the temperature according to the selected shape, e.g. aver-
age temperature of the rectangle. The value is shown inside the IR image and the control displays.

5 Reference bar: Shows the scaling of temperature within the color palette.

6 Temperature time diagram: Shows the temperature curves over time for selectable region of interest 
(ROI)

7 Histogram: Shows the statistic distribution of single temperature values.

8 Automatic / manual scaling of the palette (displayed temperature range): Man., </> (min, max), 1s : 1 
Sigma, 3s : 3 Sigma, OPT: Palette optimization

9 Distance function: Adjustment of the motor focus to focus the IR picture

10 Menu and Toolbar (Icons)

11 Icon enabling switching between color palettes

12 Status bar: Serial number, optic, temperature range, cursor position, device framerate/ display frame-
rate, emissivity, ambient temperature, flag status

Further details to the software are in the enclosed USB stick.

http://www.micro-epsilon.com/download/manuals/man--thermoIMAGER-TIM-Connect--en.pdf 
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9.3 Autonomous Operation thermoMETER TIM 8 / thermoIMAGER TIM 41

A special feature of the thermoMETER TIM 8 / thermoIMAGER TIM 41 is the autonomous operation. There is 
no need for a permanent connection to the TIM Connect software. Only a few settings must be set in advance 
in the software.

 To do this, connect the PIF and Ethernet or USB cables to the device. 
 Then connect the thermoMETER TIM 8 / thermoIMAGER TIM 41 to your PC and start the TIM Connect 

software, see 9.
 Position and focus, see 4, the camera so that your object to be measured is perfectly visible in the im-

age. 
 First define the desired measurement area with the corresponding mode you want to output.

Fig. 23 Connection thermoMETER TIM 8 / thermoIMAGER TIM 41 to PC via USB

 Now go to the configuration menu on Device (PIF). 
 There you first select the PIF type (in this case: Internal PIF). Then select under Analog Outputs (AO) the 

function that is to be output autonomously. 
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 Then press Setup, make your settings and make sure that the checkbox is set to using autonomously 
by device. 

By pressing the OK button an @ sign can be found in the configuration menu Devices (PIF), which indicates the 
autonomous operation.

Fig. 24 Configurations menu Device (PIF) Fig. 25 Setup
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9.3.1 Special Settings for thermoIMAGER TIM 41

When using the thermoIMAGER TIM 41 camera, 
an important additional setting must be made 
for autonomous operation. When all the configu-
rations have been made, it is important to write 
them to the device. This is done in the menu 
under Devices and Set configuration to 
device.

If the device is reconnected to a PC after au-
tonomous operation and the settings are to be 
transferred from the device to the  software, this 
is done in the menu under Devices and Get 
configuration from device.

Fig. 26 Set configuration to device

If the device is reconnected to a PC after autonomous operation and the settings are to be transferred from the 
device to the software, this is done in the menu under Devices and Get configuration from device.

i An arrow marked in red  means that the configuration is different between the camera and the software. 
As soon as the configuration is loaded into the device, the arrow appears in blue .

In general these are all the settings that must be set in the TIM Connect software in order to operate the device 
autonomously. You can now close the software and then disconnect the USB cable. In order to start up the de-
vice autonomously, a 5 - 30 V power supply must be connected to the terminal block. Now the used input/output 
has to be connected. The resulting value can be displayed for example on a multimeter, see Fig. 25.

When using this variant, it can last for about half a minute until the device is ready for use in autonomous mode.



Page 44

Software TIM Connect

thermoMETER TIM 8 / thermoIMAGER TIM 40 / TIM 41

Fig. 27 Electrical installation for autonomous operation of thermoMETER TIM 8 / thermoIMAGER TIM 41
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i  - Autonomous operation also works via the industrial/stackable PIF of the thermoMETER TIM 8 / ther-
moIMAGER 41. The device is powered by the power supply of the PIF.

 - Up to 9 measure areas (for TIM 8 with firmware 3013 or higher) and up to 3 measure areas 
(TIM 41) can be output autonomously. The prerequisite in this respect with the TIM 8 is the use of 
three stackable PIFs.

 -  Three analog outputs are possible per stackable PIF. The response time is 20 ms for TIM 8 and 
640 ms for TIM 41. 
Note: Several measuring areas can be combined into one measuring area via a so-called super 
area.

 - Autonomous mode cannot be set using the Main measure area  function (configuration menu 
device (PIF). To output a measure area autonomously, the function Measure area must be used.
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9.3.2 Hot-/Coldspot Function in Autonomous Operation

The setting for a hot- or coldspot in autonomous mode differs from the general procedure. It is not enough to 
mark a measuring area as hot- or coldspot. Instead, a User defined rectangle must be selected under 
the tab measure areas of the configuration dialog. In addition, under Mode, you must set whether the 
maximum (for hotspot) or minimum (for coldspot) should be output.

Fig. 28 Setting a hotspot for autonomous operation

For a hot- or coldspot output in the full field of view of the cam-
era, the user defined rectangle must also fill out this size.

Note: Predefined Layout in the software available under 
Tools and Layouts: TIM 8 Hot spot autonomous or 
TIM 41 Hot spot autonomous.

Fig. 29 Measure area over entire field 
of view
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9.4 Ethernet thermoMETER TIM 8 / thermoIMAGER TIM 41

The thermoMETER TIM 8 / thermoIMAGER TIM 41 has a direct Ethernet interface. The advantage is cable 
lengths of up to 100 m. For example, a switch can be used to extend the distances.  
The associated Ethernet cable (Order No.: TM-ETCx-TIM8) must be ordered separately. Ethernet is supported 
from software version Rel. 3.2.3020.0 and firmware 3008.

Using the Ethernet connection, the device must be supplied with power. This can be done either via:
 - the internal PIF cable via the terminal block (5 - 30 V), 
 - via the stackable PIF (5 - 25 V, Order No.: TM-PIFCx-TIM8) or 
 - via PoE (Power over Ethernet). 

i For the PoE variant, a PoE adapter (Order No.: TM-ETPOEC1-TIM8) and a PoE injector (Order No.: TM-
POE-TIM) or PoE switch (e.g. Netgear GS110TP) are also required.

-
Fig. 30 Possibilities of power supply for thermoMETER TIM 8 / thermoIMAGER TIM 41 via Ethernet connection
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9.4.1 Ethernet Setup (Point-to-Point-Connection)

After connecting the Ethernet cable to the camera and the PC, the first thing you need to do is to make the 
network settings on the PC.

i The devices are delivered with the following factory settings: 
IP address camera: 192.168.0.101 
IP address PC: 192.168.0.100 
Port number: 50101

 To do this, go to Control Panel and open the Network and Sharing Center.
 Go on LAN connection. 
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 Click on Properties.  Mark Internet proto-
col Version 4 (TCP/
IPv4) and go to Proper-
ties again.

 In the register card General 
enable the checkbox Use the 
following IP address. 

 Now enter a user defined 
IP address for your PC 
(192.168.0.100).

This must be identical to the address 
set in the TIM Connect software.

 Then close the windows with OK. 

The network settings on the PC are complete.



Page 50

Software TIM Connect

thermoMETER TIM 8 / thermoIMAGER TIM 40 / TIM 41

 Now start the TIM Connect software and activate the Eth-
ernet function.

 To do this, go to the menu Devices and Enable Eth-
ernet.

i When a Firewall windows appears, make sure to select all three network parts (domain, private, public) in order to allow the 
communication with the device.

i The approval of programs can also be activated afterwards in the Windows Firewall settings of the PC (under Windows Fire-
wall and Allow a Program or feature through Windows Firewall).
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The device is now ready for the Ethernet connection and is listed in 
the menu under Devices. The camera is identified by a network icon 
and the network address and port number.

 Select the device.

A connection to the device is established and the temperature mea-
surement can begin.

 To change the address settings, go to Devices and Ethernet 
settings (TCP/IP). 

The address for the device is assigned under Device address. This 
must have a different address (last block) to the other participant 
(e.g., PC) (Send to address (local computer)).

i It is important that the network part (first three blocks) must be 
identical for both addresses. The address range of the individu-
al blocks can be between 0 and 255.

Additionally, a separate port number must be configured. The selected number can be between 1 and 65535. 

The option auto assign port number assigns a port number automatically.

If several cameras with different port numbers are connected and a specific camera is to be communicated with, the corresponding 
camera can be determined via Listen on port number. 

i The port range used should be between 49152 ... 65535. When using other ports, it could be that they are already reserved or 
assigned.
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i When using multiple TIM 8 / TIM 41 cameras in a network, the data rate must be considered: 
- Switch with 100 Mbps/s: approx. 17 devices (TIM 8), approx. 2 devices (TIM 41 with 25 Hz) 
- Switch with 1000 Mbps/s: approx. 170 devices (TIM 8), approx. 26 devices (TIM 41 with 25 Hz) 
In addition to the data rate also make sure the power performance of the PC is high enough. Each 
device used requires its own instance.

9.5 Basic Features of Software TIM Connect

Extensive infrared camera software

 - No restrictions in licensing
 - Modern software with intuitive user interface
 - Remote control of camera via software
 - Display of multiple camera images in different windows
 - Compatible with Windows XP, Vista, 7, 8, 10 sowie LabVIEW

High level of individualization for customer specific display

 - Various language option including a translation tool
 - Temperature display in °C or °F
 - Different layout options for an individual setup (arrangement of windows, 

toolbar)
 - Range of individual measurement parameter fitting for each application
 - Adaption of thermal image (mirror, rotate)
 - Individual start options (full screen, hidden, etc.)
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Video recording and snapshot function (IR or BI-SPECTRAL)

 - Recording of video sequences and detailed frames for further analysis or 
documentation

 - Adjustment of recording frequency to reduce data volume
 - Display of snapshot history for immediate analysis

Extensive online and offline data analysis

 - Analysis supported by measurement fields, hot and cold spot searching, 
image subtraction

 - Real time temperature information within main window as digital or 
graphic display (line profile, temperature time diagram)

 - Slow motion repeat of radiometric files and analysis without camera being 
connected

 - Editing of sequences such as cutting and saving of individual images
 - Various color palettes to highlight thermal contrasts

Automatic process control

 - Individual setup of alarm levels depending on the process
 - Definition of visual or acoustic alarms and analog data output
 - Analog and digital signal input (process parameter)
 - External communication of software via Comports, DLL and LabVIEW
 - Adjustment of thermal image via reference values
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Temperature data analysis and documentation

 - Triggered data collection
 - Radiometric video sequences (*.ravi) radiometric snapshots (*.jpg,*.tiff)
 - Text files including temp. information for analysis in Excel (*.csv, *.dat)
 - Data with color information for standard programmes such as Photoshop 

or Windows Media Player (*.avi, *.jpg, *.tiff)
 - Data transfer in real time to other software programmes via LabVIEW, DLL 

or Comport interfaces
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10. Basics of Infrared Thermometry

10.1 Introduction

Depending on the temperature each object emits a certain amount of infrared radiation. A change in the tem-
perature of the object is accompanied by a change in the intensity of the radiation.

Searching for new optical material William Herschel by chance found the infrared radiation in 1800.

He blackened the peak of a sensitive mercury thermometer. This thermometer, a glass prism that led sun rays 
onto a table made his measuring arrangement.

With this, he tested the heating of different colors of the spectrum. Slowly moving the peak of the blackened 
thermometer through the colors of the spectrum, he noticed the increasing temperature from violet to red.

The temperature rose even more in the area behind the red end of the spectrum. Finally he found the 
maximum temperature far behind the red area.

Nowadays this area is called infrared wavelength area.

Fig. 31 William Herschel (1738 – 1822)
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For the measurement of “thermal radiation” infrared thermometry uses a wave-length ranging between 1 μ 
and 20 μm.

The intensity of the emitted radiation depends on the material. This material contingent constant is described 
with the help of the emissivity which is a known value for most materials, see 11.

Infrared thermometers are optoelectronic sensors. They calculate the surface temperature on the basis of the 
emitted infrared radiation from an object. The most important feature of infrared thermometers is that they en-
able the user to measure objects contactless. Consequently, these products help to measure the temperature 
of inaccessible or moving objects without difficulties. 

Infrared thermometers basically consist of the following components:
 - Lens
 - Spectral filter
 - Detector (sensor)
 - Electronics (amplifier/ linearization/ signal processing)

Fig. 32 The electromagnetic spectrum and the area used for temperature measurement

The specifications of the lens decisively determine the optical path of the infrared thermometer, which is char-
acterized by the ratio Distance to Spot size. The spectral filter selects the wavelength range, which is relevant 
for the temperature measurement. The detector in cooperation with the processing electronics transforms the 
emitted infrared radiation into electrical signals.
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Object
Infrared system

Lens Sensor Electronics Display

Fig. 33 Optical path

The advantages of non-contact temperature measurement are clear - it supports:
 - temperature measurements of moving or overheated
 - objects and of objects in hazardous surroundings
 - very fast response and exposure times
 - measurement without inter-reaction, no influence on the
 - measuring object
 - non-destructive measurement
 - long lasting measurement, no mechanical wear

Fig. 34 TIM with tablet PC
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10.2 Application Examples

Monitoring of electronic 
cabinets

Electronic development Process control extrud-
ing plastic parts

Development of elec-
tronic components

Monitoring of cables Development of me-
chanical parts

Process control at calen-
dering

Process control in solar 
cell production



Page 59

Emissivity

thermoMETER TIM 8 / thermoIMAGER TIM 40 / TIM 41

11. Emissivity

11.1 Definition
The intensity of infrared radiation, which is emitted by each body, depends on the temperature as well as on 
the radiation features of the surface material of the measuring object. The emissivity (e – Epsilon) is used as 
a material constant factor to describe the ability of the body to emit infrared energy. It can range between 0 
and 100 %. A “blackbody” is the ideal radiation source with an emissivity of 1.0 whereas a mirror shows an 
emissivity of 0.1.

If the emissivity chosen is too high, the infrared thermometer may display a temperature value which is much 
lower than the real temperature – assuming the measuring object is warmer than its surroundings. A low 
emissivity (reflective surfaces) carries the risk of inaccurate measuring results by interfering infrared radiation 
emitted by background objects (flames, heating systems, chamottes). To minimize measuring errors in such 
cases, the handling should be performed very carefully and the unit should be protected against reflecting 
radiation sources.

Fig. 35 Composition of IR radiation

I    IR radiation r   Reflection
  +    +    =  1

e   Emission t   Transmission



Page 60

Emissivity

thermoMETER TIM 8 / thermoIMAGER TIM 40 / TIM 41

Fig. 36 Spectral emissivity of several materials

  1    Enamel 3    Concrete

  2    Plaster 4    Chamotte
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11.2 Determination of Unknown Emissivity

There are 3 methods:

1 First of all, determine the current temperature of the measuring object with a thermocouple or 
contact sensor. The second step is to measure the temperature with the infrared thermometer 
and modify the emissivity until the displayed measuring value corresponds to the current tem-
perature.

2 If you monitor temperatures of up to 380 °C you may place a special plastic sticker (Part number: 
TM-ED-LS emissivity dots) onto the measuring object, which covers it completely. 

Fig. 37 Plastic sticker at metal surface

 Now set the emissivity to 0.95 and take the temperature of the sticker.

 Afterwards, determine the temperature of the adjacent area on the measuring object and 
adjust the emissivity according to the value of the temperature of the sticker.

3  Cover a part of the surface of the measuring object with a black, flat paint with an emissivity 
of 0.98.

 Adjust the emissivity of your infrared thermometer to 0.98 and take the temperature of the 
colored surface. 
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Fig. 38 Shiny metal surface Fig. 39 Blackened metal surface

 Afterwards, determine the temperature of a directly adjacent area and modify the emissivity 
until  the measured value corresponds to the temperature of the colored surface.

i On all three methods the object temperature must be different from ambient temperature.
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11.3 Characteristic Emissivity

In the case that none of the methods mentioned above help to determine the emissivity you may use the 
emissivity tables, see A 3, see A 4. These are only average values. The actual emissivity of a material de-
pends on the following factors: 

 - Temperature
 - Measuring angle
 - Geometry of the surface (smooth, convex, concave)
 - Thickness of the material
 - Constitution of the surface (polished, oxidized, rough, sandblast)
 - Spectral range of the measurement
 - Transmissivity (e.g. with thin films)

Fig. 40 Adjustment of the emissivity in the software TIM Connect under the menu item Tools / Configuration / 
Device
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12. Disclaimer

All components of the device have been checked and tested for functionality in the factory. However, should 
any defects occur despite careful quality control, these shall be reported immediately to MICRO-EPSILON or 
to your distributor / retailer.

MICRO-EPSILON undertakes no liability whatsoever for damage, loss or costs caused by or related in any 
way to the product, in particular consequential damage, 
e.g., due to

 - non-observance of these instructions/this manual,
 - improper use or improper handling (in particular due to improper installation, commissioning, operation 

and maintenance) of the product,
 - repairs or modifications by third parties, 
 - the use of force or other handling by unqualified persons. 

This limitation of liability also applies to defects resulting from normal wear and tear (e.g., to wearing parts) 
and in the event of non-compliance with the specified maintenance intervals (if applicable). 

MICRO-EPSILON is exclusively responsible for repairs. It is not permitted to make unauthorized structural 
and / or technical modifications or alterations to the product. In the interest of further development, MICRO-
EPSILON reserves the right to modify the design.

In addition, the General Terms of Business of MICRO-EPSILON shall apply, which can be accessed under 
Legal details | Micro-Epsilon https://www.micro-epsilon.com/impressum/.

For translations into other languages, the German version shall prevail.

https://www.micro-epsilon.com/impressum/
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13. Service, Repair

If the camera is defective, please send us the affected parts for 
repair or exchange.

If the cause of a fault cannot be clearly identified, please send 
the entire measuring system to:

MICRO-EPSILON MESSTECHNIK 
GmbH & Co. KG 
Königbacher Str. 15 
94496 Ortenburg / Germany
Tel. +49 (0) 8542 / 168-0 
Fax +49 (0) 8542 / 168-90
info@micro-epsilon.de 
www.micro-epsilon.com

For customers in USA applies: 

Send the affected parts or the entire measuring system back to:

MICRO-EPSILON USA 
8120 Brownleigh Dr. 
Raleigh, NC 27617 /USA

Tel. +1 919 / 787-9707 
Fax +1 919 / 787-9706 
me-usa@micro-epsilon.com 
www.micro-epsilon.com

For customers in Canada or South America applies:

Please contact your local distributor.
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14. Decommissioning, Disposal

In order to avoid the release of environmentally harmful substances and to ensure the reuse of valuable raw materials, we draw your 
attention to the following regulations and obligations:

 -  Remove all cables from the sensor and/or controller.
 -  Dispose of the sensor and/or the controller, its components and accessories, as well as the packaging materials in compliance with 

the applicable country-specific waste treatment and disposal regulations of the region of use.
 -  You are obliged to comply with all relevant national laws and regulations.

For Germany / the EU, the following (disposal) instructions apply in particular:

 - Waste equipment marked with a crossed garbage can must not be disposed of with normal industrial waste 
(e.g. residual waste can or the yellow recycling bin) and must be disposed of separately. This avoids hazards to 
the environment due to incorrect disposal and ensures proper recycling of the old appliances.

 - A list of national laws and contacts in the EU member states can be found at 
https://ec.europa.eu/environment/topics/waste-and-recycling/waste-electrical-and-electronic-equipment-weee_en. 
Here you can inform yourself about the respective national collection and return points.

 - Old devices can also be returned for disposal to MICRO-EPSILON at the address given in the imprint at https://www.micro-epsilon.
de/impressum/.

 -  We would like to point out that you are responsible for deleting the measurement-specific and personal data on the old devices to 
be disposed of.

 - Under the registration number WEEE-Reg.-Nr. DE28605721, we are registered at the foundation Elektro-Altgeräte Register, Nordost-
park 72, 90411 Nuremberg, as a manufacturer of electrical and/or electronic equipment.

https://www.micro-epsilon.de/impressum/
https://www.micro-epsilon.de/impressum/
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Appendix

A 1 Accessories 

A 1.1 Air Purge Laminar

The lens must be kept clean at all times from dust, smoke, fumes and other contaminants in order to avoid 
reading errors. These effects can be reduced by using an air purge TM-APL.

i Make sure to use oil-free, technically clean air, only. 
The needed amount of air (approx. 2 ... 10 l/min.) depends on the application and the installation condi-
tions on-site. 
The laminar air purge has a Si-protective window. Typical transmission value: 0.82 (deviations possible)
The corresponding mounting bracket TM-APLAB-TIM8/40 is mandatory. 
Material: Anodized aluminum, weight: 218 g / 494 g with mounting bracket 
Ambient temperature: 0 ... +80 °C (TAmb camera: 0 ... +50 °C); with water cooled housing up to +250 °C

Air flow

The air purge can be mounted in four different positions.

i The direction of the airflow must always be clear.

Fig. 41 Directions of airflow at different mounting positions
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Fig. 42 Laminar air purge with SI protective window TM-APL-TIM8/40, dimensions in mm
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Fig. 43 Laminar air purge with SI protective window TM-APL and mounting bracket TM-APLAB,  
dimensions in mm
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Fig. 44 Mounting bracket TM-APLAB, dimensions in mm
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A 1.2 Water Cooling

The IR camera is for application at ambient temperatures up to 50 °C. For applications at higher ambient 
temperatures we recommend the usage of the optional water cooled housing (operating temperature up to 
250 °C) and the optional high temperature cable (operating temperature up to 250 °C).

i Then using water cooling, a corresponding mounting kit (TM-WAKx-TIMxx) is required.  
Water flow rate: approx. 2 l/ min (cooling water temperature should not exceed 30 °C)

Fig. 45 Water cooling TM-W-TIM8/4 and mounting kit TM-WAK1-TIMxx, dimensions in mm
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Fig. 46 Shutter for water cooling TM-SW-TIM8/40, dimensions in mm
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A 1.3 Shutter

To protect the optics of the camera, an optional shutter (closing mechanism), can be purchased. It is 
equipped with a servomotor that can open and close a mechanical lock as needed. The special feature of the 
shutter is not only the opening and closing, but also the complete seal in the closed state. This ensures that 
the shutter is completely closed and no dirt can get on the optics.

i The shutter has a 100 ms fast-closing mode. 
Complete seal when closed. 
Includes a control box for connections. 
Shutter can be used in combination with Process Interface (PIF). 
The corresponding mounting bracket (TM-APLAB-TIM8/40) is mandatory. 
Material: Stainless steel 
Weight: 550 g / 826 g Shutter with mounting bracket 
When using more than one shutter and the opening / closing of the shutter should be simultaneously, 
the switch S4 on one control box must be set to mA and the others to mV, see Fig. 49. 
Ambient temperature: 0 ...  +60 °C (TAmb camera: 0 ... +50 °C); with water cooled housing up to 
+250 °C
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Fig. 47 Shutter TM-S-TIM8/40 with mounting bracket TM-APLAB-TIM8/40, dimensions in mm



Page 75

Appendix | Accessories

thermoMETER TIM 8 / thermoIMAGER TIM 40 / TIM 41

Fig. 48 Shutter TM-S-TIM8/40, dimensions in mm
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Fig. 49 Control box of shutter, dimensions, see Fig. 11

Power supply 12 - 24 V
Upper terminal screw Connection for Process Interface (PIF)
Switch for different operation 
modes:

S1: Switching between switch operation and pulse operation
S2: Activation/deactivation of fast-closing mode
S3: Only for factory calibration (switch must be at normal)
S4: Switching between mV or mA input

Lower screw terminal Connection for power supply, inputs (Start/Stop signal) and motor
Inputs (Start/Stop signal, max. 
24 V, input is active LOW (open 
input = HIGH))

IN 1: Trigger input for normal operation (S1)

IN 2: Currently no usage
IN 3: Trigger input for fast-closing mode (S2)
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A 1.4 Combination of Air Purge, Water Cooling and Shutter

It is possible to combine all three components (air purge, water cooling and shutter) with each other. It should 
be noted that there are differences between the TIM 8 and TIM 40. Various mounting kits TM-WAKx-TIMxx are 
available in combination with water cooling. The mounting bracket is always required for the air purge  
TM-APLAB. For water cooling TM-W-TIM8/4, the mounting bracket is included and does not have to be or-
dered separately.

             Article number

Combinations TM
-A

P
L-

TI
M

8/
40

TM
-A

PL
A

B
-T

IM
8/

40

TM
-S

A
B

-T
IM

8/
40

TM
-S

-T
IM

8/
40

TM
-S

W
-T

IM
8/

40

TM
-W

-T
IM

8/
40

TM
-W

A
K

1-
TI

M
8

TM
-W

A
K

2-
TI

M
8

TM
-W

A
K

1-
TI

M
40

TM
-W

A
K

2-
TI

M
40

Air purge
Water cooling TIM 8
Water cooling TIM 40
Shutter
Air purge and water ccoling TIM 8

Air purge and water ccoling TIM 40
Air purge and shutter
Water cooling and shutter TIM 8
Water cooling and shutter TIM 40
Air purge, water cooling and shutter 
TIM 8
Air purge, water cooling and shutter 
TIM 40
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Fig. 50 Air purge TM-APL, water cooling TM-W-TIM8/40, shutter TM-SW-TIM8/40 and appropriate mounting kit 
TIM-WAKx-TIMxx, dimensions in mm

Components
 - Air purge
 - Water cooling
 - Shutter
 - Mounting kit
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Fig. 51 Air purge TM-APL, water cooling TM-W-TIM8/40 and appropriate mounting kit TIM-WAKx-TIMxx, dimen-
sions in mm

Components
 - Air purge
 - Water cooling
 - Mounting kit
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Fig. 52 Water cooling TM-W-TIM8/40L, shutter TM-SW-TIM8/40 and appropriate mounting kit TIM-WAKx-TIMxx, 
dimensions in mm

Components
 - Water cooling
 - Shutter
 - Mounting kit
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Fig. 53 Air purge TM-APL-TIM8/40 with mounting bracket TM-FB-TIM8/40 and shutter TM-S-TIM8/40, dimen-
sions in mm

Components
 - Air purge
 - Mounting bracket
 - Shutter
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A 1.5 Outdoor Protective Housing

i The infrared camera TIM can also be used for outdoor applications by using the outdoor protective 
housing TM-OPH24-TIM8/40.  
In addition, the industrial or stackable PIF TM-CJAPIF-TIM (thermoIMAGER TIM 40) or TM-PIFCx-TIM8 
(thermoMETER TIM 8 / thermoIMAGER TIM 41) can be installed as an accessory without housing and a 
USB Server TM-USBSGB-TIM. 

Fig. 54 Outdoor protective housing for TIM camera
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A 1.6 Hardware and Software

TM-NETBox-TIM Miniature PC for 
standalone installa-
tion of TIM systems

TM-USBSII-TIM USB server for 
cable extension via 
Ethernet

A 2 Factory Settings

The devices have following presettings at time of delivery:

Temperature range -20 ... 100 °C
Emissivity 1.000
Process interface (PIF) inactive
Interprocess Communication (IPC) inactive

Measurement function Rectangle measure area
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A 3 Emissivity Table Metals

Material Typical Emissivity

Spectral response 1.0 μm 1.6 μm 5.1 μm 8 - 14 μm

Aluminum Non oxidized 0.1 - 0.2 0.02 - 0.2 0.02 - 0.2 0.02 - 0.1

Polished 0.1 - 0.2 0.02 - 0.1 0.02 - 0.1 0.02 - 0.1

Roughened 0.2 - 0.8 0.2 - 0.6 0.1 - 0.4 0.1 - 0.3

Oxidized 0.4 0.4 0.2 - 0.4 0.2 - 0.4

Brass Polished 0.35 0.01 - 0.05 0.01 - 0.05 0.01 - 0.05

Roughened 0.65 0.4 0.3 0.3

Oxidized 0.6 0.6 0.5 0.5

Copper Polished 0.05 0.03 0.03 0.03

Roughened 0.05 - 0.2 0.05 - 0.2 0.05 - 0.15 0.05 - 0.1

Oxidized 0.2 - 0.8 0.2 - 0.9 0.5 - 0.8 0.4 - 0.8

Chrome 0.4 0.4 0.03 - 0.3 0.02 - 0.2

Gold 0.3 0.01 - 0.1 0.01 - 0.1 0.01 - 0.1

Haynes Alloy 0.5 - 0.9 0.6 - 0.9 0.3 - 0.8 0.3 - 0.8

Inconel Electro  
polished

0.2 - 0.5 0.25 0.15 0.15

Sandblast 0.3 - 0.4 0.3 - 0.6 0.3 - 0.6 0.3 - 0.6

Oxidized 0.4 - 0.9 0.6 - 0.9 0.6 - 0.9 0.7 - 0.95



Page 85

Appendix | Emissivity Table Metals

thermoMETER TIM 8 / thermoIMAGER TIM 40 / TIM 41

Material Typical Emissivity

Spectral response 1.0 μm 1.6 μm 5.1 μm 8 - 14 μm

Iron Non oxidized 0.35 0.1 - 0.3 0.05 - 0.25 0.05 - 0.2

Rusted 0.6 - 0.9 0.5 - 0.8 0.5 - 0.7

Oxidized 0.7 - 0.9 0.5 - 0.9 0.6 - 0.9 0.5 - 0.9

Forget, blunt 0.9 0.9 0.9 0.9

Molten 0.35 0.4 - 0.6

Iron, casted Non oxidized 0.35 0.3 0.25 0.2

Oxidized 0.9 0.7 - 0.9 0.65 - 0.95 0.6 - 0.95

Lead Polished 0.35 0.05 - 0.2 0.05 - 0.2 0.05 - 0.1

Roughened 0.65 0.6 0.4 0.4

Oxidized 0.3 - 0.7 0.2 - 0.7 0.2 - 0.6

Magnesium 0.3 - 0.8 0.05 - 0.3 0.03 - 0.15 0.02 - 0.1

Mercury 0.05 - 0.15 0.05 - 0.15 0.05 - 0.15

Molybdenum Non oxidized 0.25 - 0.35 0.1 - 0.3 0.1 - 0.15 0.1

Oxidized 0.5 - 0.9 0.4 - 0.9 0.3 - 0.7 0.2 - 0.6

Monel (Ni-CU) 0.3 0.2 - 0.6 0.1 - 0.5 0.1 - 0.14

Nickel Electrolytic 0.2 - 0.4 0.1 - 0.3 0.1 - 0.15 0.05 - 0.15

Oxidized 0.8 - 0.9 0.4 - 0.7 0.3 - 0.6 0.2 - 0.5

Platinum Black 0.95 0.9 0.9

Silver 0.04 0.02 0.02 0.02
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Material Typical Emissivity

Spectral response 1.0 μm 1.6 μm 5.1 μm 8 - 14 μm

Steel Polished plate 0.35 0.25 0.1 0.1

Rustless 0.35 0.2 - 0.9 0.15 - 0.8 0.1 - 0.8

Heavy plate 0.5 - 0.7 0.4 - 0.6

Cold-rolled 0.8 - 0.9 0.8 - 0.9 0.8 - 0.9 0.7 - 0.9

Oxidized 0.8 - 0.9 0.9 - 0.9 0.7 -0.9 0.7 - 0.9

Tin Non oxidized 0.25 0.1 - 0.3 0.05 0.05

Titanium Polished 0.5 - 0.75 0.3 - 0.5 0.1 - 0.3 0.05 - 0.2

Oxidized 0.6 - 0.8 0.5 - 0.7 0.5 - 0.6

Wolfram Polished 0.35 - 0.4 0.1 - 0.3 0.05 - 0.25 0.03 - 0.1

Zinc Polished 0.5 0.05 0.03 0.02

Oxidized 0.6 0.15 0.1 0.1
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A 4 Emissivity Table Non Metals

Material Typical Emissivity

Spectral response 1.0 μm 2.3 μm 5.1 μm 8 - 14 μm

Asbest 0.9 0.8 0.9 0.95

Asphalt 0.95 0.95

Basalt 0.7 0.7

Carbon Non oxidized 0.8 - 0.9 0.8 - 0.9 0.8 - 0.9

Graphite 0.8 - 0.9 0.7 - 0.9 0.7 - 0.9

Carborundum 0.4 0.8 - 0.95 0.8 - 0.95 0.95

Cement 0.65 0.9 0.9 0.95

Ceramic 0.65 0.9 0.9 0.95

Glass Plate 0.2 0.98 0.85

Melt 0.4 - 0.9 0.9

Grit 0.95 0.95

Gypsum 0.4 - 0.97 0.8 - 0.95

Ice 0.98

Limestone 0.4 - 0.98 0.98

Paint Non alcaline 0.9 - 0.95

Paper Any color 0.95 0.95

Plastic > 50 μm Non transparent 0.95 0.95

Rubber 0.9 0.95
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Material Typical Emissivity

Spectral response 1.0 μm 2.3 μm 5.1 μm 8 - 14 μm

Sand 0.9 0.95

Snow 0.9

Soil 0.9 - 0.98

Textiles 0.95 0.95

Water 0.93

Wood Natural 0.9 - 0.95 0.9 - 0.95
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A 5 Industrial Process Interface for thermoMETER TIM 8 (Optional)

For use in industrial environment the industrial process interface with 500 V AC RMS isolation voltage between 
thermoMETER TIM 8 and process is available (connection box with IP65, 5 m, 10 m or 20 m standard or high 
temperature cable for camera connection, terminal block for process integration), see A 12.

Color Assignment

Green RS485 B

Yellow RS485 A

White 12 V

Brown GND

Shield GND

Fig. 55 Connections of the industrial Process Interfaces for thermoMETER TIM 8
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The industrial process interface provides the following inputs and outputs:

Designation Description max. range 1 / status

INPUT 1/2/3 Analog- or digital input 1, 2, 3 0 - 10 V 2

AO 1/2/3 Analog output 1, 2 and 3  
Alarm output 1, 2 and 3

0 - 10 V 
0/4 - 20 mA

DO 1/2/3 Relais output 1, 2 and 3 3 open/ closed (red LED on)/ 0 ... 30 V, 400 mA

FS Fail-safe-relay open/ closed (green LED on)/ 0 ... 30 V, 400 mA

i The industrial PIF has a maximum of 3 analog outputs. To use more outputs, you can cascade up to 
three PIFs, allowing you to use up to 9 analog or alarm outputs in total.

1) Depending on supply voltage; for 0 - 10 V on the AO the PIF has to be powered with min. 12 V. 
2) The AI is designed for max. 24 V, the voltage level above 10 V is not interpreted. 
3) Active if AO1, 2 or 3 is/ are programmed as alarm output.
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TIM 8

Fig. 56 Connection of 3 industrial PIFs via RS485
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i Each stackable industrial PIF must have its own RS485 address. The address must be set directly on 
the board and in the software. For the PIF which is the furthest away the 120R switch (TERM.- Termina-
tion) has to be set.

i The RS485 interface is defined for a length of 500 m.

The process interface has an integrated fail-safe mode. This allows to control conditions like interruption of 
cables, shut-down of the software etc. and to give out these conditions as an alarm.

Controlled conditions on camera 
and software

Standard Process interface 
TM-PIF-TIM8

Industrial Process interface 
TM-PIFCBx-TIM8

Interruption USB cable to camera

Interruption data cable camera - 
PIF

Interruption power supply PIF

Shut-down of TIM Connect 
software 

Crash of TIM Connect software -

Fail-Safe-Output 0 V at analog output (AO) Open contact  
(fail-safe-relay)/ green LED off
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A 6 Industrial Process Interface for thermoIMAGER TIM 40 (Optional)

For use in industrial environment the industrial process interface with 500 V ACRMS isolation voltage between 
thermoIMAGER TIM 40 and process is available (connection box with IP 65, 5 m, 10 m or 20 m standard or 
high temperature cable for camera connection, terminal block for process integration, see A 12.

Pin assignment

Color Designation

Grey Interrupt

Green SCL (I2C)

Yellow SCL (I2C)

White 3.3 V

Brown GND

Shield GND

Fig. 57 Connections of the industrial Process Interfaces for thermoIMAGER TIM 40
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The industrial process interface provides the following inputs and outputs:

Designation Description max. range 1) / status
A IN 1 / 2 Analog input 1 and 2 0 - 10 V 2)

D IN 1 Digital input  
(Low-active = 0…0.6 V)

24 V

AO 1 / 2 / 3 Analog output 1, 2 and 3 
Alarm output 1, 2 and 3

0/4 - 20 mA 
0/4 - 20 mA

DO 1 / 2 / 3 Relay output 1, 2 and 3 3) open/ closed (red LED on)/ 0 ... 30 V, 400 mA
FS Fail-safe-relay open/ closed (green LED on)/ 0 ... 30 V, 400 mA

1) Depending on supply voltage; for 0 - 20 mA on the AO the PIF has to be powered with min. 5 V < 
(1.5 + working resistance * 0.021) < 24 V. Working resistance = Load bzw. Measuring resistance;  
Example: RLoad = 500 Ohm  Umin = 1.5 + 500 * 0.021 = 12 V,  
RLoad = 100 Ohm  Umin = 1.5 + 100 * 0.021 = 3.6 V  min. 5 V 
2) The AI is designed for max. 24 V, the voltage level above 10 V is not interpreted.
3) Active if AO1, 2 or 3 is/ are programmed as alarm output.
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i The alarm output can be configured as a threshold between 0 - 4 mA for no alarm and between 
10 - 20 mA as alarm. For values outside the respective range, the relay does not switch on the DO.

The process interface has an integrated fail-safe mode. This allows to control conditions like interruption of 
cables, shut-down of the software etc. and to give out these conditions as an alarm. The time constant of the 
fail-safe is 1.5 seconds.

Controlled conditions on camera 
and software

Standard Process interface Industrial Process interface 
TM-PIFCxx-TIM

Interruption USB cable to camera
Interruption data cable camera - 
PIF
Interruption power supply PIF
Shut-down of TIM Connect 
software 
Crash of TIM Connect software -
Fail-Safe-Output 0 V at analog output (AO) Open contact  

(fail-safe-relay)/ green LED off
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A 7 Examples for a Fail-Safe Monitoring with a PLC

Fig. 58 Fail-Safe monitoring states

[1] Breakdown of PIF power supply [4] Malfunction of camera
[2] Cable break of fail-safe cable [5] Breakdown of TIM power supply/ Interruption of USB cable
[3] Interruption of cable TIM-PIF [6] Malfunction of TIM Connect software
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Fig. 59 Fail-Safe monitoring states

[1] Breakdown of PIF power supply [5] Malfunction of TIM
[2] Cable break of fail-safe cable [6] Breakdown of TIM power supply/ Interruption of USB cable
[3] Short circuit of fail-safe cable [7] Malfunction of TIM Connect software
[4] Interruption of cable TIM-PIF
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A 8 USB Cable Extension for thermoIMAGER TIM 40

The maximum USB cable length is 20 m. For greater distances between thermoIMAGER TIM 40 and  com-
puter or for stand-alone solutions the optional USB Server Gigabit is provided:

Fig. 60 USB-Server Gigabit
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A 9 A Quick Start for Serial Communication

A 9.1 Introduction
One of the feature of the thermoIMAGER TIM Connect software contains the possibility to communicate via a serial COM-PORT inter-
face. This can be a physical COM-PORT or a Virtual COM-PORT (VCP). It must be available on the computer where the TIM connect 
software is installed.

A 9.2 Setup of the Interface
 Open the Options dialog and enter the tab External Communication to enable the software for the serial communication. 

 Select the mode Com-Port and choose the appropriate port. 

 Select the baud rate that matches the baud rate of the other communication device.
The other interface parameters are 8 data bits, no parity and one stop bit (8N1). These parameters are used in many other communi-
cation devices too. The other station must support 8 bit data.

 Connect the computer with the communication device. If this is a computer too, use a null modem cable.

A 9.3 Command List

i The command list is provided on the USB stick and the TIM Connect software (Help > SDK). 
Every command must expire with CR / LF (0x0D, 0x0A).
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A 10 A Brief Overview to DLL Communication (IPC)

i The description of the initialization procedure as well as the necessary command list is provided on the 
delivered USB stick and in the TIM Connect software under Help > SDK.

2 SDK packages are available. These can be found on the delivered USB stick:
 - Connect SDK: requires the TIM Connect software
 -  Direct SDK: no TIM Connect software required, supports Linux and Windows

The communication to the process imager device is handled by the TIM Connect software (Imager.exe) 
only. A dynamic link library (ImagerIPC2.dll) provides the interprocess communication (IPC) for other at-
tached processes. The DLL can be dynamically linked into the secondary application. Or it can be done static 
by a lib file too. Both Imager.exe and ImagerIPC2.dll are designed for Windows Vista/ 7/ 8/ 10 only. 
The application must support call-back functions and polling mode.

The ImagerIPC2.dll will export a bunch of functions that are responsible for initiating the communication, 
retrieving data and setting some control parameters.

The main difference to the former Version 1 (ImagerIPC.dll) is the support of more than one TIM cameras 
via multiple instances of TIM Connect.
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A 11 thermoIMAGER TIM Connect Resource Translator

i A detailed tutorial is provided on the USB stick.

thermoIMAGER TIM Connect is a .Net Application. Therefore it is ready for localization. Localization as a 
Microsoft idiom means the complete adaption of resources to a given culture. Learn more about the interna-
tionalization topics consult Microsoft’s developer documentation on

http://msdn.microsoft.com/en-us/goglobal/bb688096.aspx.

If desired the localization process can be illustrated in detail. Also, the resizing of buttons or other visible 
resources and the support of right-to-left languages is supported. Experts who have the appropriate tools 
should handle it. To limit this effort and to enable anybody to translate the resources of the TIM Connect ap-
plication Micro-Epsilon has developed the small tool Resource Translator. 

This tool helps to translate any visible text within the thermoIMAGER TIM Connect application.
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A 12 Process Interface for thermoIMAGER TIM 40

A 12.1 Analog Output

The maximum load impedance is 500 Ohm.

The analog output can be used as a digital output too. The current value for no alarm and alarm on is set 
within the software.

A 12.2 Digital Input

Fig. 61 Digital input

The digital input can be activated with a switch to the TIM GND or with a Low level CMOS/TTL signal: 
 - Low level 0 … 0.6 V 
 - High level 2 … 24 V

Fig. 62 Button example
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A 12.3 Analog Input

Fig. 63 Analog input

Useful voltage range: 0 ... 10 V
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A 12.4 Relay Output on Industrial Interface

The analog output has to be set to Alarm.

The voltage level for AO1 - AO3 can be set in the software:
 - no alarm: 0 V
 - Alarm: 2 – 10 V

REL1-3 (D01-D03):  Umax = 30 VDC 
 Imax = 400 mA

Fig. 64 Relay output
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